Creating an Essay Using APA Style

Lone Star College – University Park
Library/Student Learning Resource Center
In this lesson...

• Finding your sources
• Evaluating sources
• Key parts of research-based papers
• Formatting your paper
• Citations
  • Works Cited
  • In-text
Finding Your Source

http://www.lonestar.edu/library/article-databases

You’ll want papers which are:
✓ Peer-reviewed
✓ Full-text
Evaluating Sources

Check for…

- **Evidence**
  - Does the information appear well-researched?
- **Credibility**
  - Is the author reliable?
- **Expertise**
  - Does the author have a valid background in the subject?
- **Relevance**
  - Is the information about your topic? Is it timely?
- **Bias**
  - Is the information opinionated? If so, acknowledge in your own paper.
Key Parts of Research-based Papers

Article will have sections discussing the
• methodology,
• results,
• discussion, and
• conclusion

in addition to the abstract, author information, and references.
METHODS

Subjects
Of 163 BPD patients, who were consecutively admitted to Personality Disorders Research Program at GATA Haydarpasa Training Hospital Psychiatric Clinic during a 24-month study period, 112 were willing and suitable to participate in the study. However, 14 patients refused to participate during

RESULTS

Table 1 shows the sociodemographic factors of both BPD and healthy control groups. Among BPD subjects, a few more men (n = 48, 54.5%) than women (n = 40, 45.5%) participated in the study. Subjects were relatively young; they ranged in age from 18 to 34 years. Groups were similar with respect to gender, age, marital status, education levels, and economic status. The two groups differed concerning occupational status; more than one third (36.4%) of BPD

DISCUSSION

The principal aim was to investigate the rate of ND and to determine the extent of self-reported dream anxiety and sleep complaints among BPD patients. This is the first study, to our knowledge, in which the VDAAS and PSQI have been used in patients with BPD.

CONCLUSIONS

The present study extends previous research and provides further support for an association between BPD, distressing nightmares, and poor sleep quality. ND is robustly related to a more severe clinical profile in BPD patients. Furthermore, the present study identifies dream anxiety as a clinical correlate of childhood trauma, current dissociative symptoms, and subjective sleep quality in patients with BPD. Effect-

REFERENCES

Spirituality and the Aging Brain

Evidence suggests that meditation, prayer, and other related religious and spiritual practices may have significant effects on the aging brain—positive effects that may help improve memory and cognition, mood, and overall mental health.

For the past thirty years, scientists have investigated the brain and behavioral effects of meditation, prayer, and related spiritual practices and experiences, using functional imaging studies to measure and interpret changes in neurotransmitter activity, such as serotonin and blood flow, and electroencephalographic changes associated with such practices. Studies have also looked at changes in hormonal and immunological function. Still other studies have examined the effects of meditation and prayer upon physical and psychological outcomes, including stress reduction and depression.

The article notes the existing knowledge and suggests an alternative to exploring the neurological correlates of these experiences. A growing number of imaging studies of meditative practices are now available in the literature. The neuroimaging techniques used in these studies include positron-emission tomography (PET), single photon emission computed tomography (SPECT), functional magnetic resonance imaging (fMRI), and functional near-infrared spectroscopy (fNIRS).

Types of Spiritual Practices

There are many approaches to meditation and prayer, each with its own set of practices and ritualistic processes. These practices are often characterized by a sense of interconnectedness with a spiritual or transcendent experience.

Neuroimaging: A Window Into Meditative States

Functional neuroimaging has opened a new window into the investigation of meditative states, offering a means of exploring these experiences. By providing a way to evaluate and understand the underlying mechanisms associated with these practices, neuroimaging studies of meditation have led to new insights into the neurocognitive processes involved.

Neuroimaging studies of meditation typically involve the use of functional brain imaging techniques, such as fMRI, to examine the changes in brain activity associated with meditation. These studies have consistently shown that meditation is associated with changes in brain activity that are distinct from those observed during other activities.

Recent studies have suggested that meditation practices are associated with a dynamic interplay between the parasympathetic and sympathetic nervous systems, which may explain the observed changes in brain activity. These findings have important implications for our understanding of the neurocognitive processes involved in meditation and their potential clinical applications.
Spirituality and the Aging Brain

Evidence suggests that meditation, prayer, and other related religious and spiritual practices may have significant effects on the aging brain—positive effects that may help improve memory and cognition, mood, and overall mental health.

In the past thirty years, scientists have explored the neurobiological and clinical effects of meditation, prayer, and related spiritual practices and experiences. Initial studies measured changes in autonomic activity, such as heart rate and blood pressure, and electroencephalographic changes associated with such practices. Studies have also looked at changes in hormonal and immunological function. Still other studies have examined the clinical effects of meditation and prayer upon physical and psychological disorders, including hypertension, cancer, depression, and anxiety.

This article reviews the existing knowledge on the neurophysiological and clinical findings associated with religious and spiritual practices and experiences, and explores the potential health effects of these practices with regard to aging.

Neuroimaging: A Window into Meditative States

Functional neuroimaging has opened a new window into the investigation of meditative states. Functional neuroimaging has opened a new window into the investigation of meditative states by exploring the neurological correlates of these experiences, and a growing number of imaging studies of meditative practices are now available in the literature. The neuroimaging techniques used in these studies include positron emission tomography (PET) (Herzog et al., 1990–1991; Lou et al., 1990); single photon emission computed tomography (SPECT) (Newberg et al., 2001; Newberg et al., 2003); and functional magnetic resonance imaging (fMRI) (Lazar et al., 2000; Brefczynski-Lewis et al., 2007; Beauregard and Paquette, 2006).

Each of these techniques provides different advantages and disadvantages in the study of meditation. Though fMRI has improved resolution over SPECT and the ability of immediate anatomic correlation, it is sometimes difficult to use for studying meditation because of machine noise. There is also the problem of requiring the subject to lie down—an atypical posture for many forms of meditation. The environment should allow subjects to have a strong meditative experience by enabling them to use the postures or actions that are part of their meditation practice. Accommodating subjects’ meditation postures is also a problem.
the individual repetitively vocalizes consonant-vowel combinations ("sa, ta, na") while touching their thumb to each of their fingers in sequence (Newberget al., 2010). The practice takes twelve minutes per day, and our subjects were asked to perform the practice for eight weeks. Before and after the eight-week meditation program, subjects were evaluated using brain imaging and also cognitive testing. Overall, we found significant increases in blood flow in the frontal lobes, which are involved with our ability to focus attention. We found approximately a 10 percent improvement in verbal memory and general cognitive function. Overall, there does seem to be some important effects of meditation on cognition, but more research is needed to elucidate how and why these effects occur.

Negative Effects of Meditation and Spirituality on Health

Although most studies have shown positive effects of meditation, religious practices, and spirituality, they may cause a negative impact on health. Meditation's most common detrimental effect is usually frustration: the practitioner struggles to perform the meditation practice. This might be for a variety of reasons, from not being able to follow the instructions properly or trying to meditate in a distracting environment, to the individual not enjoying the practice. As this frustration can turn to embarrassment and anxiety, it is important that individuals try to do meditation practices that they feel comfortable with and can perform with relative ease. While rare, there are some cases in which intense meditation has caused people to have dissociative experiences, which can be frightening. Such experiences, however, usually do not occur unless the practice is performed for many hours a day over a period of years.

Even positive experiences can sometimes have damaging effects if an individual has problems incorporating them into their current religious or spiritual belief system. Such a dichotomy can lead to anxiety and depression if it sparks a "spiritual crisis." Additionally, self-perceived religious transgressions can cause emotional and psychological anguish. When a mix of religious, spiritual, and organic sources is causing mental illness, treatment can become complicated. Healthcare workers must properly balance treating each source.

Existing evidence suggests that meditation, prayer, and other related religious and spiritual practices may have significant effects on the aging brain. Many of these effects appear to be positive, helping to improve memory and cognition, mood, and overall mental health. However, there are potential negative effects that must also be considered when beginning a particular practice. We will look to future research that may better delineate the physiological and clinical effects of these spiritual practices.

Andrew B. Newberg, M.D., is director of research at the Jefferson-Myrina Brind Center of Integrative Medicine, Thomas Jefferson University in Philadelphia.

References


Formatting: Page Layout

- 12 point font
- 1” margins on all sides
- Times New Roman or other serifed font like Courier
  - Sans-serif
  - Serif
- Double-spaced
FORMATTING: PAGE LAYOUT

- New paragraphs are indented a ½"
  - (hit the tab key once)
- When you make your works cited, everything after the first line per entry needs to be indented a ½” as well (a “hanging indent”)
The Major Paper Components

1. Title page
2. Abstract
3. The paper itself
4. References
THE TITLE (COVER) PAGE

Running head

Paper title & your information

Page number: Title page is page 1

Image from http://owl.english.purdue.edu/owl/resource/560/01/
Title of Paper

Firstname M. Lastname

Institution Name
RUNNING HEAD

• Shortened form of the title of your paper (50 characters max)
  – Highlight the running head, then Review > Word Count

• Appears on all pages of your paper in the margin
  – Insert > Header

• Title page header is different from the other pages
  – Word has a checkbox to have a “Different First Page”
RUNNING HEAD

- On the title page:
  
  Running head: TITLE TITLE TITLE TITLE 1

- On every other page:

  TITLE TITLE TITLE TITLE  #
Choosing a Paper Title: Which are good titles?

- My Paper
- Writing in APA Style: A Review of Formatting and Citations
- APA Style
- Assignment 1: Writing in APA Style
ABSTRACT

- After the title page, before your paper
- Title is centered & simply reads: Abstract
- Concise 150-250 word summary of your paper

Abstract
To set MS Word to highlight passive voice:
File > Options > Proofing > Settings (near the bottom of the window with the settings specific to Word) > scroll down to look under “Style” and check the box for passive voice

(Screenshot shown on next slide)
CITATIONS...

• give the exact location of an information source

• give credit to this source for the ideas or information within your work

• are placed on the References page of your paper as well as throughout the body
EXAMPLE CITATIONS FOR...

- Journal (online database)
- Book (print)
- Online magazine or newspaper article
- TV show or movie
Elements of a Citation for a **Journal Article**
Found in an **Online Database**

- Author(s)
- Publication date
- Title of article
- Title of journal
- Volume
- Issue
- Page numbers
- Site retrieved from or DOI

- DOI = Digital Object Identifier

Pop it into Google and that article will turn up.
Nightmare disorder, dream anxiety, and subjective sleep quality in patients with borderline personality disorder.

By: Semiz, Umit B.; Basoglu, Cengiz; Ebrinc, Servet; Cetin, Mesut

Psychiatry & Clinical Neuroscience. Feb 2008
Vol. 62 Issue 1, p48-55
8p. 4 Charts. DOI:

Subjects: NIGHTMARES; BORDERLINE personality disorder; ANXIETY; PSYCHIC trauma; PATHOLOGICAL psychology; PSYCHOLOGICAL aspects

Database: Academic Search Complete

Show all 4 images

Add to folder | Cited References: (32) | Times Cited in this Database: (2)

PDF Full Text (78KB) | Check LinkSource for more information

Elements of a Citation for a Print Book

- Author(s), if given
- Publication year
- Title
- Location and name of publisher

- If editor instead of author: Include (ed.) after editor’s name. Editor is given first in place of the author.
- If an editor AND an author: Author goes first. Editor is listed after title per above.
- If an edition of the book is noted: Included the number of the edition after the title, e.g. (2nd ed.).
Elements of a Citation for an Online Magazine or Newspaper Article

- Author(s)
- Publication date
- Article title
- Magazine title
- URL retrieved from

Retrieved from [http://www.psychologytoday.com](http://www.psychologytoday.com)
Elements of a Citation for a Movie

- Producer(s)
- Director
- Publication year
- Title
- Format
- Country of origin
- Studio or distributor
Which citation is correct?


What’s wrong with this citation?

What would the citation for this journal article look like?

Doubt's Architecture.
Subjects: RESEARCH -- Methodology; SELF-representation; WORK-life balance; ARTISTS; AESTHETICS; IDENTITY (Psychology); ANTIQUITIES; EXHIBITIONS; PHOTOGRAPHS; Independent Artists, Writers, and Performers; Convention and Trade Show Organizers
Database: Academic Search Complete
IN-TEXT CITATIONS

• Include author(s), year, and page number(s)

• E.g.

  (Author, 2012, p. 12)
  (Author, Author, & Author, 2012)
  (Author & Author, 2012, p. 12-13)
IN-TEXT CITATIONS

• So long as you have all 3 elements, you can mix up how your in-text citations are introduced:

  – According to X (2004), … (p. 19-20).

  – This is a statement (X, 2004, p. 50).

  – This has been accepted by X (2004), Y & Z (2009), and A (2008).
IN-TEXT CITATIONS

• Paraphrase
  – Do not just swap out a few words with synonyms!

• Direct quote
  – Uses “quotation marks” around the source content
  – If it’s longer than 40 words, no quotes: make it a block quote with ½” margins
When do you use in-text citations?

If you didn’t originally think it or say it, attribute it!

Exception: commonly-known facts don’t need citations.
Would you turn this in?

Source text: “These and related findings suggest the role of aesthetics in product design: attractive things make people feel good, which in turn makes them think more creatively.” – Donald Norman’s *Emotional Design* (2004)

In your paper: Aesthetics aren’t purely superficial in object design. Attractive objects make people feel good, which in turn makes them more creative in their thinking. When they’re being creative, people are better able to solve problems.
Source text: “These and related findings suggest the role of aesthetics in product design: attractive things make people feel good, which in turn makes them think more creatively.” – Donald Norman’s *Emotional Design* (2004)

In your paper: Citing a study by psychologist Alice Isen, Norman (2004) suggests that aesthetic design, by improving people’s moods and therefore making them more creative, can ultimately make them better problem-solvers (p. 19).
Would you turn this in?

Source text: “These and related findings suggest the role of aesthetics in product design: attractive things make people feel good, which in turn makes them think more creatively.” – Donald Norman’s *Emotional Design* (2004)

In your paper: Citing a study by psychologist Alice Isen, Norman suggests that aesthetic design, by improving people’s moods and therefore making them more creative, can ultimately make them better problem-solvers.
Is this plagiarism?

Here’s the latest picture I made!
Work Chronology

• Choose your topic
• Find your sources
• Create your references page
• Write your paper, referring to the works cited for your in-text citations
Other Resources

- http://www.lonestar.edu/library/citation-help.htm
- http://www.apastyle.org
- http://owl.english.purdue.edu

- Each database will have a citation help tool, but these aren’t guaranteed to be accurate!
Contact the Librarians

- UPLibrary-ref@lonestar.edu
- 281-401-5390
- In-person during normal library hours
- Look for the Chat With A Librarian button on the website